
 
SAP ABAP-Based Printer Driver for SATO Printers                                                                                                     1-38 
User Manual 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

AEPWorks 



   
 
 
 
 

 
AEP Works  2-38 
User Manual 
 

 Software License Agreement 
Please read this Agreement carefully before indicating acceptance at 
the end of the text of this Agreement. This Agreement states the 
terms and conditions upon which SATO Corporation and its 
representative (collectively, "SATO") offers you a right to use this 
software together with all related explanatory written materials and 
accompanying items including, but not limited to, the executable 
programs, drivers, and data files associated with such programs 
(collectively, "Software"). If you agree to the Terms and Conditions 
(“Terms”) of this Agreement, click on the ACCEPT button below. If 
you do not agree with the Terms, click on the DECLINE button. If you 
do not agree with the Terms, you will not be able to use the software, 
and access content only available to users that have agreed to the 
Terms. 

1. License Grant 

SATO grants you a nonexclusive license to use the Software 
installed in a single location on a hard disk or other storage 
device. 

You should not rent, lease, sublicense or lend the Software to 
third parties. You may, however, transfer all your rights to use the 
Software to another person or legal entity provided that you 
transfer this Agreement, the Software, including all copies, 
updates and prior versions, to such person or entity, and that you 
do not retain the Software downloaded from this website stored 
on a computer. Further, you agree not to place the Software onto 
a server so it is accessible via a public network such as the 
Internet or an intranet. Any transfer of the Software terminates 
your license and all associated benefits under this Agreement. 

You shall not copy, modify, decompile, disassemble, extract, or 
reverse engineer the Software. You also shall not merge any 
portion of the Software into, or integrate any portion of the 
Software with any other program. Any portion of the Software 
merged into or integrated with another program, if any, will 
continue to be subject to the Terms of this Agreement. 

 

2. Disclaimer of Warranty 

THE SOFTWARE IS PROVIDIED “AS IS”. YOU AGREE THAT 
SATO DOES NOT MAKE ANY WARRANTY AND HEREBY 
DISCLAIMS ANY WARRANTY AND REPRESENTATION 
WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT IN RESPECT OF THE 
SOFTWARE. 

WITHOUT LIMITING THE ABOVE YOU UNDERSTAND AND 
AGREE THAT THE SOFTWARE MAY NOT MEET YOUR 
REQUIREMENTS, OPERATE ERROR FREE, AND MAY 
RESULT IN DAMAGE, DELAY, PROCESSING DELAYS OR 
OTHER DIFFICULTIES WITH YOUR COMPUTER SYSTEM. 

 

3. Limitation of Liability 
IN NO EVENT SHALL SATO BE LIABLE TO YOU FOR ANY 
DIRECT CONSEQUENTIAL, SPECIAL, INCIDENTAL, OR 
INDIRECT DAMAGES OF ANY KIND ARISING OUT OF USE 
OF OR INABILITY TO USE THE SOFTWARE, INCLUDING 
BUT NOT LIMITED TO, LOST REVENUE, PROFIT, OR DATA, 
HOWEVER CAUSED AND REGARDLESS OF THE THEORY 
OF LIABILITY, WITH RESPECT TO THE SOFTWARE OR TO 
THE USE OF SUCH SOFTWARE. 
 
Some states or jurisdictions do not allow the exclusion or 
limitation of consequential, special, incidental or indirect 
damages, or the exclusion of implied warranties. 

 
4. Indemnification 

You shall indemnify and hold harmless SATO for any damages 
and loss for any breach of this Agreement by you, and for use of 
the Software by you. 
  
You further understand and agree that money damages may not 
be sufficient remedy for any breach of this Agreement by you 
and that SATO shall be entitled to seek specific performance 
and injunctive or other equitable relief as a remedy for any such 
breach or threatened breach. Such remedy shall not be deemed 
to be the exclusive remedy for your breach of this Agreement, 
but shall be in addition to all other remedies available at law or 
equity to SATO. 
 

5. Intellectual Property 
The Software is protected by copyright. 
 
This Agreement shall not be construed to transfer or to grant you 
any express or implied rights in respect of patents, copyrights, 
trademarks or other proprietary intellectual property covering the 
Software. 
 

6. General 
This Agreement shall be governed by and construed in 
accordance with the laws of Japan. 
This Agreement constitutes the entire agreement between you 
and SATO, and supersedes any prior written or oral agreements 
between you and SATO concerning the Software. No 
modifications of this Agreement shall be binding unless 
executed in writing by you and SATO. 
 
Regardless of the above, terms and conditions of an end user 
license agreement accompanying a particular software shall 
supersede the Terms in this Agreement in respect of such 
particular software. 
 
If any part of this Agreement is found void and unenforceable, it 
will not affect the validity of the balance of the Agreement, which 
shall remain valid and enforceable according to its terms. 
 
If you have any questions concerning this Agreement, please 
contact us at marketing@satogbs.com 
 

DISCLAIMER 
No distributor, dealer or any other entity or person is authorized to 
expand or alter this warranty or any other provisions of this 
Agreement. Any representation, other than the warranties set forth in 
this Agreement, will not bind SATO. 
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SATO fonts: 

The fonts SatoSans, SatoSerif, SatoSans Bold, SatoSerif Bold 
have a generous copyright, allowing derivative works (as long 
as "Sato" or the above font names are not included in the new 
fonts and font names), and full redistribution (so long as they 
are not *sold* by themselves). They can be be bundled, 
redistributed and sold with any software and any number of 
Sato printers. 

The fonts are distributed under the following copyright: 
Copyright (c) 2010 by Sato Corporation All Rights Reserved. 

Permission is hereby granted, free of charge, to any person 
obtaining a copy of the fonts accompanying this license 
(“Fonts”) and associated documentation files (the “Font 
Software”), to reproduce and distribute the Font Software, 
including without limitation the rights to use, copy, merge, 
publish, distribute, and/or sell copies of the Font Software, and 
to permit persons to whom the Font Software is furnished to do 
so, subject to the following conditions: 

The above copyright and trademark notices and this permission 
notice shall be included in all copies of one or more of the Font 
Software typefaces. 

 The Font Software may be modified, altered, or added to, and 
in particular the designs of glyphs or characters in the Fonts 
may be modified and additional glyphs or characters may be 
added to the Fonts, only if the fonts are renamed to names not 
containing either of the the words “Sato” or the above font 
names. 

This License becomes null and void to the extent applicable to 
Fonts or Font Software that has been modified and is distributed 
under the “Sato" names. 

The Font Software may be sold as part of a larger software 
package but no copy of one or more of the Font Software 
typefaces may be sold by itself. 

THE FONT SOFTWARE IS PROVIDED "AS IS", WITHOUT 
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT OF COPYRIGHT, 
PATENT, TRADEMARK, OR OTHER RIGHT. IN NO EVENT 
SHALL SATO BE LIABLE FOR ANY CLAIM, DAMAGES OR 
OTHER LIABILITY, INCLUDING ANY GENERAL, SPECIAL, 
INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF THE USE OR 
INABILITY TO USE THE FONT SOFTWARE OR FROM 
OTHER DEALINGS IN THE FONT SOFTWARE. 

Except as contained in this notice, the names Sato shall not be 
used in advertising or otherwise to promote the sale, use or 
other dealings in this Font Software without prior written 
authorization from Sato Corporation. 

Non SATO fonts bundled with applications created with this 
software: 
 
This software provides the means of adding fonts from various font 
vendors including Windows fonts. The use of such fonts in 
applications created with this software must be in compliance with 
rules and regulations stated by the font creators or vendors of these 
fonts. Organizations and persons developing applications takes on 
full responsibility to ensure compliance with their respective font 
vendor license and royalty agreements. 
 
1. Royalties and license rights 

IF FONTS FROM OTHER VENDORS THAN SATO ARE USED 
YOU AGREE TO FULFILL AND HONOR THEIR RESPECTIVE 
ROYALTY AND LICENSE AGREEMENTS. SATO CANNOT BE 
LIABLE FOR UNAUTHORIZED USE OF FONTS. 

2. Disclaimer of Warranty 
IF FONTS FROM OTHER VENDORS ARE USED YOU AGREE 
THAT SATO DOES NOT MAKE ANY WARRANTY AND 
HEREBY DISCLAIMS ANY WARRANTY AND 
REPRESENTATION WHETHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTY OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT IN 
RESPECT OF THE SOFTWARE. 
WITHOUT LIMITING THE ABOVE YOU UNDERSTAND AND 
AGREE THAT THE SOFTWARE MAY NOT MEET YOUR 
REQUIREMENTS, OPERATE ERROR FREE, AND MAY 
RESULT IN DAMAGE, DELAY, PROCESSING DELAYS OR 
OTHER DIFFICULTIES WITH YOUR COMPUTER SYSTEM. 

3. Limitation of Liability 
IN NO EVENT SHALL SATO BE LIABLE TO YOU OR TO 
FONT VENDORS FOR ANY DIRECT CONSEQUENTIAL, 
SPECIAL, INCIDENTAL, OR INDIRECT DAMAGES OF ANY 
KIND ARISING OUT OF USE OF OR INABILITY TO USE THE 
SOFTWARE, INCLUDING BUT NOT LIMITED TO, LOST 
REVENUE, PROFIT, OR DATA, HOWEVER CAUSED AND 
REGARDLESS OF THE THEORY OF LIABILITY, WITH 
RESPECT TO THE SOFTWARE OR TO THE USE OF SUCH 
SOFTWARE. 

  
 
Lua: 
 

Copyright © 1994-2008 Lua.org, PUC-Rio. 
 
Permission is hereby granted, free of charge, to any person 
obtaining a copy of this software and associated documentation 
files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, 
merge, publish, distribute, sublicense, and/or sell copies of the 
Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions: 
 
The above copyright notice and this permission notice shall be 
included in all copies or substantial portions of the Software. 
 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT 
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR 
ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN 
AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE. 
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LuaSocket 2.0.2 license: 

Copyright © 2004-2007 Diego Nehab 

Permission is hereby granted, free of charge, to any person 
obtaining a copy of this software and associated documentation 
files (the "Software"), to deal in the Software without restriction, 
including without limitation 

the rights to use, copy, modify, merge, publish, distribute, 
sublicense, and/or sell copies of the Software, and to permit 
persons to whom the Software is furnished to do so, subject to 
the following conditions: 

The above copyright notice and this permission notice shall be 
included in all copies or substantial portions of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT 
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 
THE 

AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING 
FROM, OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE. 

Expat: 

Copyright (c) 1998, 1999, 2000 Thai Open Source Software 
Center Ltd and Clark Cooper Copyright (c) 2001, 2002, 2003, 
2004, 2005, 2006 Expat maintainers. 

Permission is hereby granted, free of charge, to any person 
obtaining a copy of this software and associated documentation 
files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, 
merge, publish, distribute, sublicense, and/or sell copies of the 
Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions: 

The above copyright notice and this permission notice shall be 
included in all copies or substantial portions of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT 
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR 
ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER 
IN AN ACTION OF CONTRACT, 

TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR 
OTHER DEALINGS IN THE SOFTWARE. 

Bitlib: 
Copyright (c) 2000-2008 Reuben Thomas 
 
Permission is hereby granted, free of charge, to any person 
obtaining a copy of this software and associated documentation 
files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, 
merge, publish, distribute, sub-license, and/or sell copies of the 
Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions: 
 
The above copyright notice and this permission notice shall be 
included in all copies or substantial portions of the Software. 
 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT 
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR 
ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN 
AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE. 
 

Freetype: 
Portions of this software are copyright © 2000-2007 The 
FreeType Project (www.freetype.org). All rights reserved. 
 

zlib: 
version 1.2.4, March 14th, 2010 
Copyright (C) 1995-2010 Jean-loup Gailly and Mark Adler. 
 
 

BSD: 
Portions of this software contains software code that are 
covered by the following copyright: Copyright (c) 1989 The 
Regents of the University of California. All rights reserved. 
Redistribution and use in source and binary forms, with or 
without modification, are permitted provided that the following 
conditions are met: 
1. Redistributions of source code must retain the above 
copyright notice, this list of conditions and the following 
disclaimer. 
2. Redistributions in binary form must reproduce the above 
copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided 
with the distribution. 
4. Neither the name of the University nor the names of its 
contributors may be used to endorse or promote products 
derived from this software without specific prior written 
permission. 
 
THIS SOFTWARE IS PROVIDED BY THE REGENTS AND 
CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. 
IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS 
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGE. 
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ScintillaNET: 

ScintillaNET is based on the Scintilla component by Neil 
Hodgson. ScintillaNET is released on this same license. 

The ScintillaNET bindings are Copyright 2002-2006 by Garrett 
Serack <gserack@gmail.com> All Rights Reserved 

Permission to use, copy, modify, and distribute this software 
and its documentation for any purpose and without fee is 
hereby granted, provided that the above copyright notice 
appear in all copies and that both that copyright notice and this 
permission notice appear in supporting documentation. 

 

GARRETT SERACK AND ALL EMPLOYERS PAST AND 
PRESENT DISCLAIM ALL WARRANTIES WITH REGARD TO 
THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS, IN NO EVENT 
SHALL GARRETT SERACK AND ALL EMPLOYERS PAST 
AND PRESENT BE LIABLE FOR ANY SPECIAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES 
WHATSOEVER RESULTING FROM LOSS OF USE, DATA 
OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, 
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR 
PERFORMANCE OF THIS SOFTWARE. 

 

The license for Scintilla is as follows: 

 Copyright 1998-2006 by Neil Hodgson <neilh@scintilla.org> 

 

All Rights Reserved 

 

Permission to use, copy, modify, and distribute this software 
and its documentation for any purpose and without fee is 
hereby granted, provided that the above copyright notice 
appear in all copies and that both that copyright notice and this 
permission notice appear in supporting documentation. 

 

NEIL HODGSON DISCLAIMS ALL WARRANTIES WITH 
REGARD TO THIS SOFTWARE, 

  

INCLUDING ALL IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL 
NEIL HODGSON BE LIABLE FOR ANY SPECIAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES 
WHATSOEVER RESULTING FROM LOSS OF USE, DATA 
OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, 
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR 
PERFORMANCE OF THIS SOFTWARE. 
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Copyrights 
 

Any unauthorized reproduction of the contents of this document, in part or whole, is 
strictly prohibited. 
 
 
 
 

Limitation of Liability 
 

SATO Corporation and its subsidiaries in Japan, the U.S and other countries make no 
representations or warranties of any kind regarding this material, including, but not limited 
to, implied warranties of merchantability and fitness for a particular purpose. SATO 
Corporation shall not be held responsible for errors contained herein or any omissions 
from this material or for any damages, whether direct, indirect, incidental or consequential, 
in connection with the furnishing, distribution, performance or use of this material.  
 
Specifications and contents in this document are subject to change without notice. 
 
 
 
 

Trademarks 
 

SATO is a registered trademark of SATO Corporation and its subsidiaries in Japan, the U.S and 
other countries. All other trademarks are the property of their respective owners. 
 
 
 
 
 
 
Software updating disclaimer 

 
While all efforts have been taken to ensure accuracy and currency of the information 
contained herein, there are instances where the contents of this document may be 
outdated. In that case, proceed to SATO worldwide websites 
(http://www.satoworldwide.com) to check whether an updated document has been made 
available for your reference. 
 
Alternatively, you can consult your nearest authorized SATO technical representative, to 
obtain the relevant information about the AEPWorks Software. 
 
 
 
 
 
 
 
 
Version 1.0 
© 2012 SATO Corporation. 
All rights reserved.

http://www.satoworldwide.com/
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 Introduction 
 
 
 

 AEPWorks is a professional application development tool for creating software applications 
for SATO barcode printers that supports the AEP (Application Enabled Printing) platform. 
An application designed with AEPWorks forms a complete label printing solution that can be 
transferred to the printer. It offers an easy-to-use design interface and meets any label 
design and printing requirement needed for creating efficient label printing applications that 
can add value to users in various industries. 
 
The software can be used with 32- and 64-bit Microsoft Windows operating systems: 
Windows 
2000, Windows XP, Windows Server 2003, Windows Vista and Windows 7, and it requires 
.NET Framework 2.0 to be installed. 

   1 
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 File menu overview 
 
 
 

The File menu provides commands for creating, opening and saving workspaces and 
workspace items. 

 
 

 
 
New workspace   
To create a new workspace, select File -> New workspace... 
This will open the "New Workspace" dialog where you can choose from a collection of 
workspace templates or create an empty workspace. 

 
See New workspace for more details. 

 
Open workspace...   
Open an existing workspace. See Open workspace for more details. 

 
Close 
Closes the current editor. You will be asked to save any unsaved changes before the editor is 
closed. 

 
Close workspace 
This unloads the current workspace and will close all open editors. 

 
 
 

   2 
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Save   
Saves the active document. 

 
Save all   
Saves all open documents which have unsaved changes. 

 
Save workspace as... 
Create a copy of the current workspace in a new location. All changes after this will be saved 
to the new workspace location. 

 
Export item... 
Lets you export the current document to a file. 

 
Print   
If a printer has been connected, this will print the active format if the printer is set to 
"Online" mode. 

 
Recent workspaces 
This menu allows you to quickly access the most recent workspaces you have opened with 
AEPWorks. 
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2.1 New workspace 
 
 

  New workspace 
 

To create a new workspace, select File -> New workspace... 
This will open the "New Workspace" dialog where you can choose from a collection of 
workspace templates or create an empty workspace. 

 
 

 
The "New Workspace" dialog 

 
Empty workspace 
To create an empty workspace, select "Empty workspace" and enter a name for the 
new workspace. To choose a different location, click the "Browse" button and select 
the target directory where the new workspace will be created. 

 
Workspace from 
template 
AEPWorks also includes a collection of template workspaces. To create a new 
workspace from a template, select the template that you wish to use and enter a new 
name. 

 
When you select a template, a short description will be shown 
below the list. 
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2.2 Open workspace 
 
 

  Open workspace 
 

To open an existing workspace select File -> Open workspace... 
 
A dialog will be displayed where you can select a workspace file to open. Supported file types 
are .aepws and .pkg. 

 
 
Workspace file 
An .aepws file represents a workspace that was created with AEPWorks Pro and gives 
unlimited access to the workspace content. 

 

  .aepws icon 
 
 
Package file 
A .pkg file represents a compiled workspace. It has some limitations, such as not being able 
to remove locked files or fields, not allowing functions to be opened. 

 
For more details, see Workspace restrictions.  
 

  .pkg icon 
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 Edit Menu 
 
 
The Edit menu provides commands for easy manipulation in the active editor. 

 
 

 
 
Undo   
Undo the most recent action in the active editor. 

 
 
Redo   
Redo the most recent action in the active editor. 

 
 
Cut   
Cut the selected object in the active editor and place it on the Clipboard. 

 
 
Copy   
Copy the selected object in the active editor and place it on the Clipboard. 

 
 
Paste   
Paste an object from the Clipboard to the active editor. 

 

   3 
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 View Menu 
 
 
The View menu provides commands to open panels that are used in AEPWorks. 

 
 
 

 
 
 
Workspace explorer 
The Workspace explorer displays the items that are contained in the current workspace. It 
provides functions to add, rename and remove specific items. For more details, see 
Workspace explorer. 

 
Field properties   
The Field properties window displays detailed information about fields in a format. It also 
gives you control of various properties of a field. For more details, see Properties. 

 
Field browser   

 

The Field browser displays a list of all fields in an active format. It also enables you to change 
the order of fields. For more details, see Fields. 

 
Immediate window   
The Immediate window provides a Lua console which allows you to execute inline Lua scripts 
and see the output. This should only be used by users with knowledge in the Lua scripting 
language as it might lead to unexpected behavior if used incorrect. 
 
For more details, see Immediate window. 

   4 
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 Workspace Menu 
 
The Workspace menu provides functions to modify the current workspace. 
You can add new items, import files, change firmware and modify printer settings. 

 
 

 
 
 
 
Add item   
Use this to create a new item to add to the workspace. When expanding this menu item 
the sub-menu shown below will appear. 

 
 

 
 
 
Select the item type that you wish to create and a dialog will appear to let you input all 
necessary properties. 

 
For more information, see chapter "Workspace Items". 

 
 
Add existing item   
Use this to import already existing Formats, Tables or Functions into the current workspace. 

 
 
Import library function...   
Shows the "Function Library" dialog which lets you choose from a collection of functions that 
are included in AEPWorks. 

   5 
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From here you can choose a function to import to your workspace. Select a function in the list 
to see more details about it. 
Firmware 
From here you can switch between different firmware versions. 

 
 
Printer settings 
Opens the printer settings dialog. This contains both printer specific settings and 
application settings such as printer network settings, application locale settings, printer 
sensor type etc. 
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 Tools Menu 
 
The Tools menu provides functions to setup AEPWorks and interact with a connected AEP 
printer. 

 
 

 
 
Update printer   
This will update the connected printer with the current workspace. 

 
 
Connect printer...   
Opens the "Connect printer" dialog which will let you connect to an AEP printer via USB or 
LAN/WLAN. 

 
 
Package builder...   
Opens the "Package builder" dialog which will compile a package file from the current 
workspace. 

 
 
Language 
Sets the language of AEPWorks. Note that a restart of AEPWorks will be required. 

 
 
Options... 
Shows the "Options" dialog where you can set AEPWorks application options. For more 
details, see Options. 

   6 
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 Main Window 
 

 
 

 
 

The AEPWorks main window and its panels/areas. 
 
 
1. Workspace explorer 
The Workspace explorer displays the items that are contained in the current 
workspace. It provides functions to add, rename and remove specific items. For 
more details, see Workspace explorer. 

 
2. Editor area 
This is the area where all editors will open. 

 
3. Properties 
The Field properties window displays detailed information about fields in a 
format. It also gives you control of various properties of a field. For more 
details, see Properties. 

 
4. Toolbar 
The toolbar contains several buttons and controls for executing various commands. When 
opening some editors the toolbar will be populated with additional controls that are specific for 
the editor. For more details, see the Toolbar topic.

   7 
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7.1 Workspace explorer 
 
 

 
 
The workspace explorer displays all workspace items in a list, ordered by type. 

 
To add, open, copy, delete or rename an item, right-click on it to display the menu as 
shown below. 

 

 
 
Add item   
Lets you create a new item to add to the workspace, or import existing items. 
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Open   
Opens up the selected item in an editor window to let you modify its content. 

 
Open   
Opens up the folder where the selected item is stored. 

 
Copy   
Creates a copy of the selected item and adds it to the workspace. 

 
Delete   
Removes the selected item from the workspace and from the file system. 

 
Rename 
Lets you rename the selected item. 

 

7.2 Properties 
 
 
Properties 

 
The properties panel displays field properties when a format is open and one field is 
selected. It will display all available properties of the selected field and lets you edit them. 

 
 

 
The Properties panel when no field is selected. 
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The Properties panel when a text field is selected. 

 
For more details, see Editing a format. 
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7.3 Fields 
 
The fields panel displays the field order within the currently open format and it also allows you 
to re-order them. 

 

 
 
For more details, see Editing a format. 

 

7.4 Immediate window 
 
The Immediate window provides a Lua console which allows you to execute inline Lua scripts 
and see the output. This should only be used by users with knowledge in the Lua scripting 
language 
as it might lead to unexpected behavior if used incorrect. 
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7.5 Toolbar 
The toolbar contains several buttons and controls for executing various commands. Some 
editors will populate the toolbar with additional controls that are specific for the editor. 

 

 
 

The toolbar with a set of common controls 
 

  New workspace 
Open the "New workspace" dialog. 

 
  Add item 

Add a new item to the workspace. 
 

 
  Open workspace 

Shows the "Open workspace..." dialog. 
 

  Save 
Saves the item in the currently active editor. 

 

 
  Save all 

Saves all open items. 
 

 
  Cut 

Cut the selected object and place it in the Clipboard. 
 

 
  Copy 

Copy the selected object and place it in the Clipboard. 
 

  Paste 
Paste an item from the Clipboard. 

 

 
  Undo 

Undo the last action in the active editor. 
 

  Redo 
Redo the last undo action in the active editor. 

 
  Package builder 

Open the "Package builder" dialog that lets you compile a package from the current workspace. 
 
 

  Direct print 
This will print the active format if the printer is set to "Online" mode. 

 

 
  Update printer 

This will update the connected printer with the current workspace. 
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 Format Overview 
 

8.1 Formats 
 
A Format represents a label that can be printed on an AEP printer. It contains various fields 
such as text, images and barcodes. The AEPWorks format editor provides a WYSIWYG 
(What You See Is What You Get) tool that lets you create fields, edit their properties, and at 
the same time see the actual result during the design time. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A sample format as shown in the format editor. 

 
See Editing a format for more details. 

 

   8 



   
 
 
 
 

 
AEP Works  25-38 
User Manual 
 

8.2 Editing a format 
To open a format for editing, double click on it in the workspace explorer or right click on it and 
select "Open". 

 
The format will be opened, as shown below: 

 
 

 
 
 
When the format editor is active, the toolbar will contain the format specific controls as shown 
below: 

 

 
 
Format properties 
When the format editor is active and no fields are selected, the following toolstrip is shown: 

 

 
 
This shows the format properties and allows you to edit them. 

 
  Table 

If the format is connected to a table, click this button to open the table editor. Use the drop-
down to select which table to use together with the format. For more details see Connecting to 
a table. 

 
Width / Height 
Displays the format size and allows you to edit the width and height. 
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Selectable 
If checked, the format will be available for selection in the printer. If unchecked, the format will 
not appear in the Format list in the printer. 

 
 
Designer controls 
There are some controls that provide visual aids to the format editor: 

 
 

  Show grid lines 
If this is enabled the format designer will display a grid on the format and all fields will snap to 
this when they are moved. When this is disabled, fields can be aligned to other existing fields. 

 
  Show annotations 

If this is enabled, every field will have annotation icons that show what kind of source the 
selected field have, and also in which order the fields are placed within the format. 

 
Rotate left 
Rotate right 

Rotate left and rotate right will rotate the entire format in the designer. This makes it easy to 
design labels no matter of which direction it is printed in. 

 
The grey arrows next to the format shows in which direction the format will be printed, 
depending on the current printer configuration. 

 
 
Adding new fields 

 

 
 
 

  Create a new Text field 

  Create a new Textbox field  

  Create a new Barcode field  

  Create a new Image field 

  Create a new Line field 

  Create a new Box field 

 
Select field type to create and click on the format to place it. 
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Field properties 
All fields have properties such as position, data source, formatter etc. Some properties are field 
specific and will only be shown when such field is selected. 

 
Some properties are available in the toolstrip that is displayed when selecting a field. 

 
 

 
- Text displays the field type of the selected field. 

 
- Field name displays the name of the selected field, this can be edited. 

- To set the anchor point of a field to left, center or right, use the buttons. 
 

- To toggle a field between visible/not visible, check or uncheck the   property.  

For more details about field properties, see  Field properties. 
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8.3 Field properties 
Depending on the type of the selected field, different properties will be shown. Below is a 
list of properties for each field type. 

 
 

A list of properties and which fields that use them: 
 

Property name Description Used by types 
Field name Sets the field name  
Anchor point Sets the anchor point of a field  
Formatter Sets the formatter of a field  
Visible Sets wether the field will be printed or not  
Source Sets the data source of a field  
Location Sets the x;y coordinates of a field  
Script Sets a pre-, round or post-script on a field  
Font Sets the font of a field  
Font size Sets the font size of a field  
Direction Sets the direction (angle) of a field  

 

Symbology 
Sets the barcode symbology for a barcode 
field 

 

 
 

Line thickness Sets the line thickness of a line or box field  
 
 

  Text field 

  Textbox field 

  Barcode field 

  Image field  

 Line field 

  Box field 
 
 

Select a field in the format to display its properties. 
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8.3.1 Source 
The source property is used to set the source from which the field will get its data. 

The default value is Text, which sets the field data to the specified text value. 
 

 
Other source types are: 
Script 
A lua script is used to set the value. 

 
 
List 
A list of values is used to set the value. When printing the format, a prompt will appear and let 
the user select one item from the list. 

 
 
Table 
If the format is connected to a table (see  Connecting to a table for more details) this lets you 
specify from which column in the table that the field should retrieve its value. 

 
 
Input 
The field value will be set from user input when the format is printed. This lets you specify the 
prompt text and the input mode (text or numeric). 
 
 
Copy 
The field value is set to copy another field's value. 
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Time 
The field value is set to the current time. Use a Date & Time formatter to format the data. 

 
 
Counter 
The field value will be set to the starting number and is increased by 'step' after each label 
print in a batch job. When the print job is done, counter will be reset. 

 
 

8.3.2 Formatter 
The formatter is used to format the field value. It also allows you to add a prefix or postfix to 
the field. 

 
 
The available formatters are: 

 
 
Custom 
Can be used to specify if the value should be formatted as text or a number and also set a 
max length and decimal count. 

 
 
Currency (sign) 
Adds a currency sign to the field. The currency sign is depending on the current regional 
settings. For example, if the current locale setting is "English US" the currency text will be "$". 

 

 
Currency (text) 
Adds currency text to the field. The currency text is depending on the current regional settings. 
For example, if the current locale setting is "English US" the currency text will be "USD". 

 

 
Date & Time 
Lets you format the field value as a date or time. This can be useful for fields with a Time 
source for example. A number of predefined date & time formats are available to choose from. 

 
 
Number 
Formats the field value as a number. This formatter uses the current locale setting to determine 
which comma sign, thousand separator etc should be used. 

 
 
Script 
Lets you define a script to use for formatting the field's value. 

 
 

8.3.3 Script 
Lets you choose from a set of functions to perform operations on the field's value. 
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8.4 Connecting to a table 
To connect a format to a table, choose an existing table from the drop-down or select 
"(New table...)" to open the "Create new table" dialog. 

 
 

 
 
When a table is connected to the format, click the table link button ( ) to open the table 

editor. See Table editor overview for more details on how to use the table editor. 
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 Table Editor 
Overview 
 

9.1 Table overview 
In the table editor you can edit data, change column properties and import and export table 
data. 

 
 
 

 
 
 
 
To edit rows, right click on the row header to display the menu as shown below, which lets 
you perform various row operations. 
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To edit columns, right click on a column header to display the column menu, as shown below. 

 

 
 
 
 
Import / Export table data 
The table editor lets you import or export data from/to Microsoft Excel files and Microsoft 
Access Databases. To import data the column names in your table must exactly match those in 
the file you are importing from. 

 
 
To export data, click the "Export data..." button ( ) which will open the "Export data" dialog. 

To import data, click the "Import data..." button ( ) which will open the "Import data" dialog. 
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 Function Editor 
Overview 
 

10.1 Function editor 
To open a function for editing, double click on it in the workspace explorer or right click on it 
and select "Open". 

 
The function editor will be opened, as shown below: 
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 Profile Overview 
 

11.1 Profile editor 
To open a profile for editing, double click on it in the workspace explorer or right click on it 
and select "Open". 

 
The profile editor will be opened, as shown below: 
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 Connect Printer 
 
 
 
To select which printer to use from AEPWorks, select the "Connect printer" from the Tools 
menu. The following dialog will be shown: 

 

 
 
 
Make sure that the AEP printer is connected and powered on, the printer will then be listed 
either in the "Port name" list or in the list of network printers depending on the interface type 
on the printer (USB or LAN/WLAN). 

 
It is also possible to manually enter an IP address. 

 
NOTE 
AEPWorks can only find network printers on the same subnet. To connect to a printer on 
another subnet, the IP address needs to be manually entered. 
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 Package Builder 
 
 

 
To build a package from the current workspace, select the "Package builder" from the 
Tools menu. 

 
This lets you choose which files to include in the package. 
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Extensive contact information of worldwide SATO 
operations can be found on the Internet at 
www.satoworldwide.com 
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